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Operator Safety Summary 
 

The general safety information in this summary is for operators of the Exicor® 
MicroImager. Specific warnings and cautions may be found throughout the manual 
where they apply but may not appear in this summary. 

Terms 

DANGER statements identify conditions or practices that will result in personal injury 
or loss of life. 

WARNING statements identify conditions or practices that could result in personal 
injury or loss of life. 

CAUTION statements identify conditions or practices that could result in damage to 
the equipment or other property. 

NOTICE statements identify conditions or practices that are important in proper use 
of the equipment to get the expected results. 

Labels 

The system identification label below is placed on the rear of the MicroImager frame. 
 

  

Figure 1 System identification label 

The wording on this label is: 

Model Name _____, Serial No. _____, Manufacture Date: _____. 

Power Source 

This product is intended to operate from a power source that will not apply more 
than 250 volts rms between the supply conductors or between either the supply 

7245 NW Evergreen Pkwy 
Hillsboro, OR 97124 USA 

(503) 690-2000 

Model: Exicor MircroImager SN: 0010 
    

Mfd: June 2014   

Electrical Ratings 
     

Output: 24VDC at 4.2 Amps Max 

 

Class 2 per EN60825-1 (2007) 
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conductor and ground.  A protective ground connection by way of the grounding 
connector in the power cord is essential for safe operation. The user should supply 
power to the system that will provide at least the following amount of current at the 
corresponding supply voltage: 

100-240VAC, 50/60Hz, 1.5A MAX 

The MicroImager system uses a single AC power cord to power a DC power brick.  If 
the power cord needs to be replaced for any reason, make sure that the 
replacement cord is rated for the voltage and current noted above  

Do Not Operate without Covers 

To avoid personal injury, only operate this product with all covers and panels 
installed. 

Light Safety 

The light source is located in the bottom module of the system. It is a 4 wavelength 
LED that outputs <1mW. Removing any covers can expose a user to the LED light. 
The light beam path is shown in Figure 2. 

 

CAUTION 

Avoid direct eye exposure to the beam and to reflections from 
shiny objects. 

This or any other low power LED can cause a temporary 
inability to see clearly. 

Use of controls or adjustments or performance of procedures 
other than those specified herein, may result in hazardous LED 
light exposure. 

Persons other than qualified maintenance personnel should not 
unnecessarily remove covers. 
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Figure 2 Light beam path 

Mechanical Safety 

Be careful to have hands clear of any pinch points while operating the focus block 
and sample stage. 

Electrical Safety 

Rear panel outlets, other than the DC input are only USB 3.0 connectors which do 
not exceed 5 Volts.    

The Exicor® MicroImager contains no user-serviceable components. Refer any 
maintenance or adjustment needs to Hinds Instruments, Inc. 

Do not allow any liquids to get inside the equipment. 

Maintenance of the other elements of the system should be referred to Hinds 
Instruments, Inc. or other trained personnel (i.e. computer, monitor, etc.)  

 

 

 

Light Beam 
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1 
System Overview  

 

The Exicor® MicroImager is a highly sensitive polarization imaging system that 
utilizes different microscope objectives to image very small features of samples. It 
measures retardation and fast axis angle. Samples need to be flat/planar and 
transparent to the wavelength that is being used.  

 

System Description 

Listed below are the main components of the system.  See Figure 3 for the 
component layout. 

Top Module: The Top Module houses the top half of the optical components 
(polarization state analyzer) of the imaging system. 

Focus Block: The Focus Block has both fine and coarse adjustment knobs. Use the 
larger outer knob to adjust the coarse focus and the smaller inner knob to adjust the 
fine focus.  

Bottom Module: The Bottom Module houses the electronics of the system as well 
as the bottom half of the optical train (polarization state generator) for the system. 
The bottom half also houses the light source. 

Sample Stage: The Sample Stage can be moved in the vertical direction by the 
focus block while having an X travel of 76mm and a Y travel of 50mm. 

Microscope Objective: The MicroImager comes with a variety of different options in 
objectives, most commonly in 2X, 5X,10X and 20X. The system comes equipped 
with an objective turret for ease of switching objectives. When changing objectives, 
the focus block may need to be readjusted to bring the sample back into focus. 
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Figure 3 System main components 
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Figure 4 Main optical components of the system 
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General Dimensions 

 

 

 
 

Figure 5 Dimensions 
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2 

System Operating 
Requirements/Setup  

Component Placement 

The computer and monitor need to be placed within 0.5 meter of the system to 
facilitate connection of all hardware control cables.   

Power Connections 

The Exicor® MicroImager system is designed to use an external DC power supply 
that outputs 24VDC while accepting 100-240VAC, 50/60 Hz.  User adjustment 
should not be necessary for any internal components due to changes in power. 

The Exicor® MicroImager system requires a single power outlet.  The computer and 
monitor need to be powered separately from a user-supplied wall outlet or outlet 
strip.   

Calibration 

The Exicor® MicroImager has been calibrated by Hinds Instruments, Inc. prior to 
shipment. The instrument should require no further adjustment for most applications.  
Regular use of offsets will ensure the best low level sensitivity for all measurement 
parameters. Hinds Instruments recommends daily offsets in a moderately 
temperature stable lab and hourly in an unstable environment. 

 

Note: All systems sold by Hinds Instruments are currently installed and  
 supported only through Hinds Instruments, Inc. and authorized  
 distributors. 
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3 

Operating the System  
 

WARNING 

The Exicor® MicroImager contains hazards such as: bright 
visible light and pinch points. 

All operators should be aware of the location of the main power 
switch 

To ensure continued safety, all operators should familiarize 
themselves with the Operators' Safety Summary section, 
beginning on page 6. 

System Initialization 

To initialize the Exicor® MicroImager system, starting with the power off: 

1. Confirm the power and USB cables are correctly connected to the system. 
The USB requires a USB 3.0 port on the PC. 

2. Turn the power switch to the ON position. The power switch is found on the 
rear panel of the machine. 

3. Launch the software by double clicking on the MicroImager desktop icon.   

 

During hardware initialization, the user might notice the LED and camera will 
initialize using the settings from the previous use. 

If the correct comport is used/referenced and there are no other errors during the 
initialization phase, the main window will come up as shown in Figure 6.   
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Figure 6 Main Window 

If an error is witnessed during the initialization phase, see section 7 “Troubleshooting 
& Help” on page 33 for system initialization errors. 

In the case that the hardware has already been powered up, such as from a 
computer restart, simply start the software. 

System Warmup 

For accurate measurements, it is important to let the system warm up. The critical 
component that needs to warm up is the camera. The camera’s temperature can be 
monitored by the Ximea CamTool package installed on the system PC. There should 
be a shortcut on the desktop. The settings window has a “Temperature” drop down 
that will give real time camera temperature. Camera’s tend to hit stability while in 
Hinds Instruments’ lab around 51-55°C: 

 

Figure 7 Ximea CamTool settings window w/ temperature expanded 
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Loading a Sample 

This system includes a basic manually operated sample stage. The best way to get 
reproducible measurements is to make a custom sample holder that fastens to the 
stage in a repeatable way.  Hinds Instruments can also supply custom sample 
holders as an option. 

Use the following steps to load a sample: 

1. Place the sample on the stage. Do not hold the sample to the stage in a way 
that might put stress on the sample. 

2. Using the manual adjusters, move the sample to the desired location on the 
software’s live screen. The adjustment knob controls both the X and Y-axis 
adjustments. The X-axis is controlled by the bottom part of the knob. The Y-
axis is controlled by the top part of the knob. See Figure 8. 

 

 

Figure 8 Stage axis controls 

Note: It is preferable to wait at least 10 minutes before measuring samples 
after handling in order for the sample to reach thermal equilibrium.  Handling 



Chapter 3: Operating the System 

Exicor MicroImager User Manual  17 

the sample can change its temperature temporarily, which may also affect the 
retardation measurement.  The wait time may be different for samples of 
different sizes or different material.  

Measuring a Sample 

1. Choose the color of light desired by clicking the corresponding checkbox. 
Multiple colors can be selected. 

2. Set the Light Level/Exposure. This can be done using the “Auto Expose” 
button or by hand. 

a. By Hand: The LED current slider and user entry box will adjust the 
current supplied to the LEDs. The exposure slider and user entry box 
will adjust the exposure time of the camera. The goal is to achieve an 
intensity peak near 0.5 using the intensity histogram.  

b. Multiple LEDs can be auto exposed at once if multiple LED check 
boxes are checked and the “All” checkbox next to the “Auto Expose” 
button is checked. 

3. If an offset is desired, load an air offset hmi file using the “Load offset” button. 
Make sure the “Use offset” box is checked. It is recommended to take an air 
offset at minimum daily. If the system is in an unstable temperature 
environment, hourly offsets are suggested. 

a. To take an offset, remove all samples from the beam path and follow 
these “Measuring a Sample” steps. Ensure that the “Use offset” is not 
checked in case an old offset has been loaded.  

4. Set the number of averages at each harmonic to make the measurement. It is 
recommended to use 4-16 averages for the best results in a timely manner. 

a. **This is the preferred way to capture offset files. 

5. Press the “Collect” button. 

6. Additional Settings: Expand the additional settings to use the following 
functions: 

a. Select the optical parameters to measure. **Early systems will only 
allow linear retardation measurements.  

b. If you would like the software to automatically save the data to a local 
location, check the “Enable HMI Autosave” box, name the file and 
select if a timestamp is desired and use the directory explorer from the 
“Set” button to select where the file is saved. 

Once the scan starts, there is a status bar at the bottom showing the amount of 
progress of the scan. 

When the scan is complete, the software will switch to the Data tab and display the 
results as shown in Figure 9. 
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Figure 9 Completed scan 

If the data needs to be saved and auto save was disabled, simply select FileSave 
and select which data format to save or quickly save a comma separated value 
(.csv) using the “Export” button in the data tab’s left panel.  

System Shutdown 

1. Close the MicroImager software using the close button in the top right corner 
or navigate to FileQuit. 

Move the start/stop switch to the OFF position.  All hardware devices inside the 
system will shut down.  The PC and monitor can be shut down independently if 
necessary. 
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4 
Software Interface 

 

Depending on the options purchased with the MicroImager, different software 
options may be available. This chapter explains the rest of the software interface in 
detail, including: 

 Calibration 

 Opening Files 

 Setting Exposure 

 Changing Objectives 

 Offsets 

 Display of Data 

 Evaluation of Data 

 Analysis 

 Multi-Order Samples 

Calibration 

The system does not need to be recalibrated on a regular basis but it is up to the 
user to decide if they want to recalibrate the system. Reasons Hinds Instruments 
would recommend recalibration include the following: 

1. Moving the system from to a different room with drastically different 
temperatures. 

2. There has been a substantial effect of some kind upon the instrument to 
doubt the calibration. 

3. The system is not measuring reference samples correctly. 
 

For more information on how to calibrate the instrument see Section 5 Calibration. 

File Management 

Saving: To save a file in the format that the Microimager can reload go to 
FileSave or use the “Enable HMI Autosave” checkbox in the left panel of the “Live 
view” tab. 

Export: To export the data in a .hmi, .csv or the heat map in a .png file, go to 
FileExport. A .csv file can also be exported from the “Data” tab. This location also 
allows the user to set how many pixels to average over for smaller files.  

If the .png tool is used, the .png will be of the region of the heat map currently in 
view. 
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Opening: To open a file, go to FileLoad, and select the corresponding .hmi file. 

Setting Exposure & Live Views 

During the calibration, the software determines the optimal setting for the exposure 
and brightness for a blank sample. Pressing the “Auto Expose” button runs the same 
routine to find the optimal settings. 

If the sample has low transmission, it is possible to use the LED current and camera 
exposure slider bars to increase the amount of light entering the camera. Left is 
minimum and right is maximum for both bars. You can move the sliders to the right 
until the optimal brightness is achieved. Optimal brightness is when the intensity 
histogram peaks near 0.5. 

The live view can switch between a standard view and polarized view. The polarized 
view gives some contrast to view high retardance areas in real time. This aids in 
focusing on areas of interest without waiting for a scan. 

Changing Objectives 

To change objectives, rotate the objective turret to the target objective. Ensure you 
hear the turret click into place. Click the Auto Expose button to readjust the light 
intensity for that objective or adjust the LED current and exposure time slide bars 
appropriately for each LED being used. 

Offsets 

The offset button is found above the collect button in its own designated box. 

Clicking this button will open a file explorer that should be used to select an .hmi file 
of a measurement of air with no sample in the path, using the intended objective. 
The retardation and angle of every pixel will then be stored in memory from this file 
to be subtracted after a new measurement.  

After you take an offset, you can choose to use the offset or not by checking the box 
above the offset button. 

A loaded offset will display which optical parameters and color combinations have a 
value that will be applied. For example, a blue/red, linear retardance offset will 
display as: 
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Figure 10 Offset Tool 

Each objective will have its own unique offset. For example, an offset taken with the 
2X objective should not be used with any objective other than the 2X. 

A daily offset is recommended for systems used in a stable temperature 
environment. More frequent offsetting is recommended in less stable environments. 

Display of data 

The data tab contains a heat map of the measured data, a histogram of the current 
view of data, overall statistics (mean, standard deviation, minimum and maximum) 
and the same statistics of the current zoomed region.  

 

Figure 11 Data Tab 

Optical Parameters: Data is displayed in 5 Different formats. Intensity, Retardance 
Magnitude (|LR|), Retardance Angle (LR Angle) and the raw X and Y component 
data. The XY data are the raw values used with the intensity data to calculate the 
magnitude and angle. Each parameter has its own set of units to choose for viewing. 
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Hovering the mouse over the heat map data will display point data of the image pixel 
captured with the mouse. The tool tip will display the coordinate x and y location 
along with the selected optical parameter as the z value. 

The retardance angle data can be displayed as a vector field at any time by 
checking the “Vector plot active” checkbox. The length of the vector can be adjusted 
using the “Range _ pixels” box. 

Image Resolution: A scale bar can be enabled at any time using the “Enable 
resolution bar” check box in the “Magnification” group. Selecting the objective used 
will scale the heat map data to keep the scale bar appropriate. Based on the 
objective and zoom, the scale bar will adjust and display the resolution in microns.  

Color: When displaying single sets of data the gradient scale to the right of the heat 
map provides the legend to the data. The minimum and maximum values can be 
clicked and dragged to adjust up or down. The “Reset Gradient” button in the left 
panel will reset the value to the original values.  

To change the color gradient, use the “Color Gradient” dropdown of presets. There 
are nine (9) available options, including options optimized for users with difficulty 
perceiving colors or contrast.  

Navigation:  

A user can left click and drag the heat map to pan in any direction. 

The mouse wheel can be used to zoom in and out of the heat map.  

An area can be zoomed in on when captured with a right click and drag. 

Double left click of the mouse will reset the heat map or the “Reset View” button in 
the left panel.  

 

Analysis  

The data analysis tools are on the right side panel as shown in Figure 13. 
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Figure 12 Analysis Toolbar 

Histogram: The top of the analysis tool contains a histogram of the data that is 
currently held in the heat map, meaning if you zoom, the histogram will display only 
the data of the region of the sample that is zoomed on. The x axis is the unit of 
measurement selected by the “Units” dropdown box and the y axis is the number of 
pixels at that value (count). The histogram will update with any zoom or pan of the 
heat map. Hovering over the histogram will display the pixel count (y value) at that 
location. All navigation tools of the heat map apply to the histogram as well: 

- Pan with left click and drag. 

- Zoom with mouse wheel or right click and drag. 

- Reset view with double left click or “Reset View” button. 

Statistics: Below the histogram are two sets of statistical data: the overall “Data 
statistics” of the entire sample and the “Region statistics” of any feature zoomed in 
on. The statistics include the mean value of the area, the standard deviation of data 
in that area, as well as the minimum and maximum value in the area. The region 
statistics will update with any zoom or pan of the heat map. 

Region Tools: Several region tools are available for highlighting areas of interest 
from the data. Each shape, with exception of a single line, will report area statistics 
and statistics of pixels captured by the perimeter. The line shape will only report 
statistics from any pixel captured by the line. Clear all regions from the data map 
using the “Clear Region Selection” button. 
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The available regions are: 
 

 Line- simple two point line. Start and finished with one left click each. 

 Polyline- functions similarly as line, but with multiple vertices. Finished when 
left click is near the starting vertex. 

 Rectangle- simple rectangle. Start and finished with one left click each. 

 Ellipse- all manner of round shapes. Start and finished with one left click 
each. First click will set the center, the next click will set the radius. Zoom will 
affect area becoming elliptical. 

 Polygon- multiple lines but will enclose an area. Start with one left click and 
add vertices with single left clicks. Finished with one left click near the starting 
vertex. 

Statistics will automatically populate after a region is selected. The dropdown 
menu in “Region statistics” will allow a user to switch between area and 
perimeter statistics if applicable.  

Comma separated value file (.csv) of the region can be created by using the 
“Export” button in the “Export Region CSV” group. 

 

Multi-Order Samples 

Occasionally, there is a need to measure retardation beyond the limit of a single 
wavelength. To do this multiple wavelengths need to be measured and unwrapped 
to find the correct order and value of a sample. 
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To complete this: 

1. Measure your sample with multiple wavelengths. To do this, check the 
checkbox of the wavelength in the “Light source control” box of the main 
interface. 

2. After a multiple wavelength scan is complete, the “Phase Unwrapping” box of 
the Data tab will enable itself. From here, the user can select which 
wavelengths to use to unwrap the data by checking the checkbox next to the 
color name. A user can adjust the scaling factor of the LED wavelength using 
the text box. LED sources inherently have a wide bandwidth that may drift 
with temperature changes. This tool allows for flexibility in the wavelength 
used in the phase unwrapping algorithm. 

 

Figure 12 Phase Unwrap groupbox. 

3. After selecting which colors to use in the unwrapping, adjust the minimum and 
maximum expected retardation values as well as the dispersion of the 
material, if known, and click “Unwrap”. The software will not allow a maximum 
input larger than the system is capable of measuring. 

It will take some time but the software will process the images and give you a 
multi-order result. 
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5 
Calibration 

Calibration Setup 

Before beginning the calibration procedure, a few tools will need to be acquired. The 
calibration process requires a high quality achromatic quarter wave plate with known 
axis of polarization. A precision rotation stage is also required. Some sort of 
temporary adhesive (i.e. sticky tack) is helpful, but not necessary.  

The calibration software can be accessed on the “Calibration” tab of the main 
interface. 

Before beginning, make sure the system is properly warmed up and in a thermal 

environment that is comparable to the normal conditions the system will be used in.  

Additionally, ensure that the stage is level. Measure each edge of the stage as 

shown in Figures 13 and 14. The stage will move slightly with light to moderate 

pressure. If it isn’t possible to make the stage level, remove the panel behind the 

stage with a M3 hex wrench, then loosen the stage, level it, and retighten the 

screws. Check to make sure the stage is level again after retightening the screws. 

 

Figure 13 Measuring Left Side of Stage. 
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Figure 14 Measuring Right Side of Stage. 

 

Calibration Procedure 

1. With the calibration tab open, start with the Exposure calibration and work 

down the list of harmonic and amplitude calibrations. To begin a calibration, 

select the procedure and press “Collect”. Procedures will display whether they 

are complete or incomplete. After pressing collect, the software will designate 

which optic and at what orientation to place the optic for the procedure. Some 

call for air. In this case, make sure there is nothing in the beam path but clean 

glass from the stage. If an optic is required, ensure the optic is centered. To 

do so, select “Cancel”, switch to the “Live view” tab, run through the following 

procedure and go back to the “Calibration” tab to run the procedure. 

2. Centering an optic: Place the rotation stage with the Hinds supplied 

alignment pinhole onto the stage and fix it with blue sticky tack. It should look 

like Figure 15. Generally, it’s best to have the mark facing forward for ease of 

reading the measurement. 
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Figure 15 Position of Rotator.  

3. Switch to the “Live view” tab in the software and move the sample stage until 

the rotation stage with the pinhole is centered in the middle of the display. It 

should look like Figure 16. You may need to increase the intensity of the light 

by adjusting the LED current slide bar. 

4. Remove the pinhole alignment tool. Return to the calibration tab and run 

the next calibration step. 

 

Figure 16 Centering Pinhole.  
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5. As the calibration procedure runs, it will plot data points in the current LED 

color. When complete with a color, a line fit of the data points will appear.  

 

Figure 17 Calibration procedure in process 

 

 

Figure 9 Completed calibration procedure 
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6. Retardance Scaling: Before beginning the retardance scaling procedure, 

center an achromatic quarter wave plate in a precision rotator using the 

centering procedure above. Note: It is helpful to orient the rotator so that you 

can see the angle indicator. This procedure requires precise rotation of the 

optic by the user. After aligning the waveplate, remove the pinhole 

alignment tool.  

7. Mark the x direction of the sample stage with either a piece of tape as shown 

in Figure 18 or note the value on the ruler. It doesn’t matter what is chosen, 

so long as the stage can be put back in the same position. 

 

Figure 18 Marking Location.  

8. After marking the center on the x-axis, move the rotation stage out of the way 

by only turning the x-axis adjustment. 

9. Start the retardance scaling procedure. After the first data set (air) is 

complete, a pop up will prompt you to move the wave plate back into the 

beam path. The first measurement should be taken with the rotator marked at 
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0 degrees, though it doesn’t matter if the waveplate’s optical axis is in line 

with the rotator. 

10. The software requires the calibration sample to be measured at eight different 

orientations. These should be measured with the precision rotator marking 0, 

22.5, 45, 67.5 90, 112.5, 135, 157.5 and 180 degrees.  

11.  After completing all calibration parameters, the system is ready to use. 

**NOTE: The new calibration parameters will save to the system’s 

configuration files on the PC. To ensure proper storage, use the close window 

button or File→Quit to exit the software. Any other method or powering down 

the PC without exiting the software could result in loss of the data. 
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6 
Maintenance 

The Exicor® MicroImager requires very little maintenance. 

Basic System Check 

Check periodically, and when system maintenance is performed, that the covers on 
the source and detector modules and the control system are secured properly.  Be 
certain that no unwanted light escapes from the source module. 

Check periodically that interconnecting cables are free of sharp bends and cuts or 
abrasions. 

For safety, the instrument housings should be opened only by authorized 
maintenance personnel. 

Persons changing the cables or opening the covers on the system must: 

 Remove power to the system. 

 Understand the purpose, connections and voltages at each cable connection. 

 Understand the hazards associated with bright LED light. 

 Not allow eye exposure directly from LED light or any reflection of LED light from 
a mirror like surface. 

 Understand all mechanical and electrical hazards that exist in the system. 

Cleaning the Exterior 

When cleaning the exterior of the Exicor MicroImager, care should be taken not to 
scratch the surface or let liquids get inside the system.   

An ammonia-based cleaner (such as glass cleaner) works well for cleaning the 
outside.  Do not allow any liquids to get inside the sample stage components or top 
and bottom modules.  

CAUTION 

To avoid electrical shock and equipment damage, do not allow 
any liquids to get inside the Exicor MicroImager. Do not clean 
the system with the power ON or while the system is plugged 
into an AC outlet. 
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7 
Troubleshooting & Help 

Diagnosing Common Errors 

Table 1 Diagnosing common errors lists some of the most common errors that have 
been encountered and suggestions on how to interpret or fix the error. 

Symptom Common Causes Actions 

1.  
Start/Stop switch will 
not turn system on 

DC power cord not plugged in Plug in DC power cord 

2.  
The software can’t 
connect to the 
camera 

USB 3.0 cable not plugged in. 

USB is plugged into USB 2.0 
PC port. 

The computer went into sleep 
mode. 

The settings file COMPort is 
not the system COMPort. 

Plug in the USB 3.0 cable. 

Make sure cable is plugged into USB 3.0 
port of the PC.  

Unplug and then plug back in the USB 
3.0 to turn the camera off and then back 
on again. 

Check settings file. 

3.  
Measurements are 
not close to 
expected values 

The camera is being over 
exposed. 

Use the auto expose button or turn the 
exposure down manually. 

4.  
The software 
freezes 

An error within the software 

Unplug the USB cable from the 
computer and turn off the system. Then 
plug the cables back in and turn the 
system back on. Be sure to plug USB 
cables back into the same port on the 
PC.  

Restart the software. 

Table 1 Diagnosing common errors 
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Contacting Hinds Instruments 

If it is necessary to contact Hinds Instruments for support, refer to the following table 
for the company contact information. 

Method Information 

Telephone 
Monday - Friday 8:00 AM to 4:00 PM PST  

(503) 690-2000 

FAX  (503) 690-3000 

Email  sales@hindsinstruments.com 

World Wide 
Web 

www.hindsinstruments.com  

Shipping 
Address 

Hinds Instruments, Inc. 

7245 NE Evergreen Pkwy. 
Hillsboro, Oregon 97124 

Table 2 Contacting technical support 

When contacting Hinds Instruments for technical support, have the following system 
information available: 

 Model name 

 Serial number 

 Problem symptom 

 MicroImager data files, configuration files, and offsets files (if applicable) 

 

 

 

 

  

mailto:support@hindsinstruments.com
https://www.hindsinstruments.com/
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A 

Technical Specifications 
The Exicor MicroImager is an easy-to-use system for imaging the birefringence in 
optical materials.  The system includes a sample stage to move the sample for 
measuring areas up to 76 x 50 mm and function with 2X, 5X,10X and 20X 
objectives.  

General Specifications 

Software: Exicor™ MicroImager (025-0000-075) Ver. 2.0 

Computer System: PC, Windows operating system, LCD monitor 

System footprint area: 265 mm x 361 mm (10.4” x 14.2”) 

System height: 771 mm (30.4”) 

Stage Travel: 76mm x 50mm 

Weight: 15.79 kg (34.74 lbs) 

Power Required: 100-240VAC, 1.5A MAX, 50/60Hz 

Measurement Specifications 

LED Colors: 
Blue, Green, Orange, Red * 
*system specific wavelengths displayed in software 

Field of View:  

2X 4.941 mm  x 4.123 mm 

5X 1.83 mm x 1.53 mm 

10X 0.876 mm x 0.731 mm 

20x 0.437 mm x 0.364 mm 

 
Microns/Pixel: 

 

2X 2.00 microns 

5X 0.74 microns 

10X 0.36 microns 

20x 0.18 microns 
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Fast Axis Angle  

 Units: degrees (°) 

 Range: -90°  +90° 

 Resolution: 0.5 Degrees 

 

Software Features 

A system-specific software program provides the following: 

 Graphical user interface 

 Multiple wavelength Measurement 

 Multi-order retardation measurement 

 Auto-exposure  

 Color plot of all measurements 

 Automated data collection and analysis of samples 

 On-screen graphing of sample data 

 Automatic calibration check, system initialization, and system status monitoring 
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Exicor® MicroImager 

Limited Warranty 
 

Hinds Instruments, Inc. warrants the Exicor ® MicroImager to be free from defects in 
materials and/or workmanship for (1) year from the date of delivery, subject to the 
provisions contained herein.  Hinds’ warranty shall extend to the original purchaser 
only and shall be limited to factory repair or replacement of defective parts. 

Exclusions 

This warranty does not cover consumable parts, normal maintenance or damage 
resulting from improper use or repair, or abuse by the user.  This warranty extends 
only to repair or replacement, and shall in no event extend to consequential 
damages.  In the event of user repair or replacement, this warranty shall cover 
neither the advisability of the repair undertaken, nor the sufficiency of the repair 
itself. 

THIS DOCUMENT REFLECTS THE ENTIRE AND EXCLUSIVE UNDERSTANDING 
OF THE PARTIES, EXCEPT AS OTHERWISE PROVIDED HEREIN.  HINDS 
EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
PARTICULARLY THE WARRANTIES OF MERCHANTABILITY AND/OR FITNESS 
FOR A PARTICULAR PURPOSE FOR THE PRODUCTS, SOFTWARE, OR 
SERVICES CONVEYED.  THE OBLIGATIONS SET FORTH IN THIS SECTION 
SHALL BE HINDS’ SOLE LIABILITY AND BUYERS’ SOLE REMEDY, FOR 
BREACH OF THE FOREGOING WARRANT.  REPRESENTATIONS AND 
WARRANTIES MADE BY ANY OTHER PERSON, INCLUDING DISTIBUTORS, 
DEALERS AND OTHER INDEPENDENT REPRESENTATIVES OF HINDS WHICH 
ARE INCONSISTENT OR IN CONFLICT WITH THE TERMS OF THIS WARRANTY 
SHALL NOT BE BINDING ON HINDS UNLESS REDUCED TO WRITING AND 
APPROVED BY AN EXPRESSLY AUTHORIZED OFFICER OF HINDS. 

This warranty gives you specific legal rights, and you may also have other rights that 
vary from state to state. 

 

Warranty Service 

If you find any defects in material or workmanship or any failure to meet the 
specifications, you must notify Hinds within the warranty period and obtain a Return 
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Material Authorization Number (RMA#).  This can be done by calling Hinds 
Instruments at 1-800-688-4463, or by emailing our service department.  Return the 
product to us in proper packaging, freight and insurance prepaid, and clearly marked 
with the RMA#, and we will either repair or replace it, at our option. 

Non-Warranty Repairs 

If a product that is not covered by the above warranty needs repairing, we will first 
provide an estimate of repair charges and then repair the product upon receiving 
authorization from you.  Repairs are warranted for ninety (90) days from the date of 
delivery. 

Reference chapter 7 (Troubleshooting & Help) on page 33 for contacting technical 
support. 
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